Exercise 23: Vector Geoprocessing using ModelBuilder

This exercise will explain how to create a model using ArcGIS ModelBuilder.
Here, we will specifically focus on the analysis of vector data. You will
produce a simple model that summarizes the area of palustrine wetlands
that may be impacted by a proposed highway. Once the model is produced,
you will create a new tool in ArcToolbox that can be used by other analysts.
ModelBuilder offers an intuitive and graphical means to build a multipart
process that does not rely on coding or scripting.

Topics covered in this exercise include:

1. Implement ArcGIS ModelBuilder to work through a multipart process
2. Create a ModelBuilder tool containing vector geoprocessing functions
3. Create a new toolbox

4. Create an ArcToolbox tool from a ModelBuilder process

Step 1. Open a Map Project
First, we need to download and open the Exercise_23.aprx file.

1 Download the data from https://www.wvview.org/. All
lab materials are available on the course webpage and linked to the
exercise. You will need to extract the compressed files and save it to
the location of your choosing.

71 Open ArcGIS Pro. This can be done by navigating to All Apps followed
by the ArcGIS Folder. Within the ArcGIS Folder, select ArcGIS Pro.
Note that you can also use a Task Bar or Desktop shortcut if they are
available on your machine.

[l After ArcGIS Pro launches, select "Open another project.”

Open another project

"1 Navigate to the directory that houses the material for this course. The

project files are in the folder where it was saved on your
local machine.
[l Select . Click OK to open the project.

01 If necessary, navigate to the WV map.

Note: If you'd prefer, you can also just click on the file
within the uncompressed folder directly to launch ArcGIS Pro.

1



https://www.wvview.org/

This project contains a single map that contains two data layers.

TuckerCounty_CorridorH: line feature representing a proposed highway
route

wetlands: polygon features representing wetland extents from the National
Wetland Inventory (NWTI)
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Step 2. Create a New Toolbox

Before you begin the analysis, you will need to create a new toolbox in which
to save your model. You will do so using ArcCatalog.

71 In ArcGIS Pro, navigate to the View Tab then select Catalog View. This
will open the Catalog View if it is not already open.

71 In the Catalog View, double-click on Toolboxes. This will open a list of
available toolboxes.

71 Right-click in the toolbox space within the Catalog View then select
New Toolbox. Provide a name to save the new toolbox.

Note: Each project has a default toolbox associated with it. You can use this
toolbox. Here, we are having you create a new toolbox so that you know
how to do so. Tools, such as models, must be saved inside of toolboxes.



Step 3. Creating the Model

71 Return to ArcGIS Pro. You will not need to use ArcCatalog again in this
lab, so you can close it if you'd like.

[1 Navigate to the Analysis Tab then select ModelBuilder
under the Geoprocessing area. This will open the

ModelBuilder window. MeodelBuilder
01 In the ModelBuilder Tab, click on the Save As button. =
"1 Navigate to the toolbox you just created and save the Save
model in the toolbox as . As

In this exercise, you will specifically focus on impacts to palustrine wetlands.
So, impacted wetlands will be those that are within 1 km of the proposed
highway and are palustrine.

Here are the required steps:

1. Buffer the proposed highway using a 1 km buffer distance.

2. Select any wetlands that are palustrine and extract them from the
larger dataset.

3. Clip the palustrine wetland using the road buffer.

4. Calculate the area of the wetland within a new field.

5. Summarize the field to obtain the total area impacted.

This section will guide you in creating the model. Once your model is
complete, it should look like the model presented below.

Add Geometry Summary

TuckerCounty... — Buffer —  Road_Buffer —» Clip —  wefland_clip — Attributes — wetland clip (2) — Stalistics —> total_area
IS
wetlands > Select = palustrine_wet._

First, change the environment settings for the ModelBuilder so that the

outputs are automatically saved to the geodatabase in
the folder.
71 In the ModelBuilder Tab and in the Model area, select &

the Environments button. _
] Set the Current Workspace and the Scratch Workspace Environments
to the geodatabase.
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71 Click OK to save these environment settings.

Environments X
Search Rl =
Workspace
Current '\.'I'L'I:II'kEPECE Exerc se_'l g gdb
Scratch Workspace Exercise_19.gdb

Note: Environment settings changed within ModelBuilder are only honored
by operations performed within the model, not by all operations performed
within the project.

01 Add the two input layers to the model by dragging them from the
Contents Pane to the model area.

There are many options for adding tools to the model.

71 Right-click on the Tools button under ModelBuilder. This will open the
Geoprocessing Pane. In the Geoprocessing Pane, click on Toolboxes to
view ArcToolbox. Tools can be added by dragging them from
ArcToolbox to the model area.

. Add the following tools to the model.

1. (This can be found in the Proximity subtoolbox of the
Analysis Toolbox.)

2. (This can be found in the Extract subtoolbox of the
Analysis Toolbox.)

3. (This can be found in the Extract subtoolbox of the Analysis
Toolbox.)

4, (This can be found in the Features
subtoolbox of the Data Management Toolbox.)

5. (This can be found in the Statistics
subtoolbox of the Analysis Toolbox.)

You will now need to specify the settings for each tool. The outputs will
automatically save to the geodatabase, as this was
defined as the working directory. To edit the settings for each tool, click on
each tool to open up the wizard. Once you have specified the desired
settings, click OK to accept the changes. Note that links between inputs and
tools and tools and outputs will be created as you change the settings.



11 Specify the settings for all tools.
Buffer

1 Input Features = TuckerCounty_CorridorH
1 Output Feature Class = Road_ Buffer

71 Linear Units = Kilometers

'l Distance = 1

71 You do not need to change any other settings.

Select

01 Input Features = wetlands
(1 OQOutput Feature Class = palustrine_wetlands
1 Clause

a. Field = WET_TYPE

b. Operator = “Begins With”

c. Values =P

Note: This will extract all records in which the wetland type begins with the
letter P. This will be all of the palustrine wetlands.

Clip

01 Input Features = palustrine_wetlands

01 Clip Features = Road_Buffer

71 Output Feature Class = wetland_clip

71 You do not need to change any of the other settings.

Add Geometry Attributes

1 Input Features = wetland_clip

1 Geometry Properties = Area

71 Area Units = Acres

(1 Coordinate System = Current map [Map] (should be NAD 1983 UTM
Zone 17 North)

' You do not need to change any of the other settings.

Summary Statistics

[ Input Table = wetland_clip(2)
71 Output Table = total_area
[ Statistics Fields
a. Field = "POLY_AREA”
b. Statistic Type = “SUM”
71 You do not need to change any of the other settings.
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You should now have a completed model that looks like the one shown
above.

(1 Save your model by clicking on the Save button in the

Model area of the ModelBuilder Tab. Sr'
dve
Note: You can make your model graphic a little neater by using
the Auto Layout button. This can be used to make the graphic D
more orderly. Blue indicates inputs, indicates tools or Auto
processes, and green indicates outputs. e

Step 4. Execute the Model

Now that you have a complete model, it can be executed. Before you
execute the model it is generally a good idea to validate the model.

71 Click on the Validate Tool in the Run area of the

ModelBuilder Tab to validate the model. If no issues are

flagged, no issues were detected. LTI
1 You can now run your model. Do this by clicking the Run

Button in the Run area of the ModelBuilder Tab.

Fun

{1 Once the model executes, no layers will be added to your map. You

will need to add the and the outputs to

the map to answer the questions below. To do this, right-click on the
output model graphic then select Add to Display.

rapnic surrer
Add To Display

[ Create Labe’
Add To Display

lultiple Ring Buffer

Rename ]
Rernove From Display.
D Aeanon

Use the results to answer the following questions.

Question 1. What is the name of the attribute column that holds your
calculated total area measurement in the table?

Question 2. What is the total acreage of wetlands impacted by the road
construction?



Question 3. What is the name of the attribute column that holds your
calculated area for each wetland in the wetland_clip(2) layer?

Question 4. What is the largest acreage of a single wetland impacted by the
road construction?

Step 5. Creating a Tool from a Model
Models can be used like other tools made available in ArcToolbox. However,

this does require some additional work. Let’s start by adding your new
toolbox that contains the model you just created.

(1 Save your model again by clicking on the Save button in the .
Model area of the ModelBuilder Tab. [

| Close the ModelBuilder window. S2oZ

1 Navigate to the Catalog Tab.

71 In the Catalog Pane, right-click in the Toolboxes area. Catalog

11 Select Add Toolbox.

71 Navigate to the folder. Click on your toolbox followed by
OK to add it.

1 Back on the Catalog Tab, double-click in the Toolbox area. You should

now see your toolbox in the list.

IS Catalog x || EANYETS

(_-/l T/' I:‘ » Project » Toolboxes »

Exercise_19.thx

Maxwell_Tools.thx

=

71 If you double-click on the added toolbox, the contents will be
displayed. It should just contain your model.

Catalog X |:| Map

(—J' T,' |:| ¥ Project » Toolboxes » Maxwell_Toolsd

wetland_tool

) -

= SoE

11 Double-click on the model to open it as a tool. Note that it opens in the
Geoprocessing Pane. However, it only says No Parameters.
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Geoprocessing

®© wetland_tool =

Parameters | Ervircnmeants @

Mo Parameters

Why can’t you specify any settings? This is because you did not specify any
user-defined parameters. You will need to do so if you want someone to use
your model as a tool and not interact with it directly. We will now guide you
through that process.

[l Close the Geoprocessing Pane.
71 Back in the Contents Pane, right-click on the model then select Edit.
This will open the model so that it can be edited using ModelBuilder.

Open etland_toal

- Edit tion
Add To Analysis Gallery

Add ToFa Edit

1 Edit the source of the tool.

You will begin by setting the input highway als a parameter and giving it a
more meaningful name.

Open...

"1 Right-click on the blue circle that says
TuckerCounty_CooridorH.

71 Select Parameter.

1 Next, select Rename and change the
name to “Proposed Highway.” Do not
include the quotes here or in any of the steps below.

Parameter

Add To Display

ﬁ/ Create Label | Parameter N

Renarme Remaove model parameter.




71 Using similar methods, define the input as a parameter and
change the name to "Wetlands Features” and set it as a parameter.

71 Using similar methods, change the output name to
“Impacted Wetlands 2.” Do not define it as a parameter.

71 Change the name of the final output, total area, to “"Output Table” and
make it a parameter.

1 Change the name of the buffer output to “Buffer Output” and make it a
parameter.

. Change the name of the select output to “Palustrine Wetlands” and
make it a parameter.

This tool would be much more robust if you could change the buffer
distance. Luckily, you can specify this as a user-defined parameter also.

71 Right-click on the in the model. Select Create Variable
followed by From Parameter. Select Distance [value or field].
= : npac
ffi Open.. d Buffer —» Clip — Wetla
Run
'
Create Variable » From Parameter 4 Distance [value or field]
Messages... From Environment  » Side Type
B/ Create Label ‘ End Type
Rename Dissolve Type
le |:| Group il"lB_WGt._, Dissolve Field(s)
Uocut Method
Efl Copy
Select All

11 Right-click on this new variable then select Parameter to add it as a
user-defined parameter.

P

Proposed

Highwar

ST P P P

| Impacted _ Add Geometry Impacted Summary |
(B ey — E " Wetlands Attributes " Wetlands 2 " Statistics g CUPrEnE
Distance
[value or f... T
P ‘ P

Wetlands Palustrine
Features Eeled ~ 7 Wetlands

[l Click Save in the Model area of the ModelBuilder Tab to save these
changes.
1 Close the model.



71 Return to the Catalog Tab. Double-click on Toolboxes followed by your
toolbox.
71 Double-click on your model to open it in the Geoprocessing Pane.

Now, your model has parameters that can be specified by the user. So, the
end-user can use this like any other ArcToolbox tool. They do not need to
interact with the model directly.

71 Change the distance to 2 kilometers and re-execute the tool. You will
also need to rename the outputs.

Geoprocessing
® wetland_too =

Parameters | Ervircnments

Proposed Highway
TuckerCounty_CorridorH

Wetlands Features
wetlands

i, Output Table
total_area

1. Impacted Wetlands
wetland_clip

Distance [value or field] Linear Unit -
2| |Kilometers -

Buffer Qutput
Road_Buffer +

Palustrine Wetlands
palustrine_wetlands

Note: If you do not change the names of the outputs the original outputs
will be overwritten. That is why there are warning symbols next to these
parameters. If the outputs are loaded into your map, the tool will fail as the
files cannot be overwritten.

Use the results to answer the following questions.

Question 5. What is the largest acreage of a single wetland impacted by the
road construction using a buffer distance of 2 kilometers? (2 Points)

Question 6. What is the total acreage of wetlands impacted by the road
construction using a buffer distance of 2 kilometers? (2 Points)

Question 7. What is the difference in total acreage between the area of
impact defined using the 2 kilometer buffer vs. using the 1 km buffer?
(2 Points)

Step 6. Rename Tool
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You can give the tool a more meaningful hame using the Properties Button in
the Model area under the ModelBuilder Tab. Alternatively, this can be done
within the Catalog Pane. Here, we will demonstrate the Catalog Pane.

71 Navigate to the Catalog Pane followed by Toolboxes.
11 Right-click on the model within your new toolbox. Select Properties.

Open
Edit

Add To Analysis Gallery
Add To Favorites

Add To Model

B Copy
®  Delete

D View Metadata
EE' Properties

From this menu, you can give the tool a more descriptive name by changing
the label.

1 Change the label to rename the tool.
Question 8. What did you name the tool? (2 Points)

You will have to select Save from the Model area under the ModelBuilder Tab
to complete the label change.

END OF EXERCISE
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